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Abstract

These Application Notes describe the procedures necessary to configure Avaya IP Office 9.0
and Avaya Session Border Controller for Enterprise 6.3 to support Remote Workers. The SIP
endpoints used as Remote Workers included Avaya Flare® Experience for Windows and
Avaya one-X® Mobile Preferred for IP Office.

Testing was performed to verify SIP registration and basic functionalities in audio calls for the
remote endpoints. Calls were placed to and from the Remote Workers residing outside of the
enterprise, across the public internet, to various Avaya endpoints located at the enterprise.

These Application Notes describe the provisioning used for the sample configuration shown in
Figure 1. Other configurations may require modifications to the provisioning steps described
in this document. Testing of additional supported Remote Worker SIP endpoints, not listed
under these Application Notes, is outside the scope of this document.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.
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1. Introduction

These Application Notes describe the procedures necessary to configure Avaya IP Office 9.0 and
Avaya Session Border Controller for Enterprise 6.3 (Avaya SBCE) to support Remote Workers.

A Remote Worker is a SIP endpoint that resides in the untrusted network, registered to IP Office
at the enterprise via the Avaya SBCE. Remote Workers offer the same functionality as any other
endpoint at the enterprise. The SIP endpoints used as Remote Workers in the reference
configuration included Avaya Flare® Experience for Windows and Avaya one-X® Mobile
Preferred for IP Office on Apple and Android.

In the sample configuration, the IP Office system consisted of an Avaya IP Office Server Edition
solution, which included a Primary Server running the Avaya IP Office Server Edition Linux
software, and an IP Office Expansion System (V2), on an IP500V2 chassis.

Testing was performed to verify SIP registration of the Remote Workers located outside the
enterprise to the Avaya IP Office Primary Server, via the Avaya SBCE. Audio calls were placed
to and from the Remote Workers to various Avaya IP Office endpoints located at the enterprise
to verify basic functionality.

The Avaya Session Border Controller for Enterprise (Avaya SBCE) functioned as the enterprise
edge device providing protection against any external SIP-based attacks. For privacy over the
public internet, the public side of the Avaya SBCE facing the remote workers should be
configured to use the recommended values of TLS for signaling and SRTP for media encryption,
as long as they are supported by the endpoints.

2. General Test Approach and Test Results

A simulated enterprise site containing the Avaya IP Office Server Edition Solution and the
Avaya SBCE was installed at the Avaya Solution and Interoperability Lab. A separate location in
the Lab containing the Remote Workers was configured to connect via the public network to the
Avaya SBCE at the simulated enterprise site.

The configuration shown in Figure 1 was used to exercise the features and functionality tests
listed in Section 2.1.
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2.1. Test Coverage
To verify Remote Worker basic functionality, the following areas were tested:

Remote Worker endpoints registrations to the Avaya IP Office Server Edition Primary
Server.

Inbound audio calls to Remote Workers from different types of Avaya endpoints located
at the enterprise. The Remote Workers clients used were Avaya Flare® Experience for
Windows and Avaya one-X® Mobile Preferred for IP Office.

Outbound audio calls from Remote Workers to various Avaya endpoint types located at
the enterprise. The Remote Workers clients used were using Avaya Flare® Experience
for Windows and Avaya one-X® Mobile Preferred for IP Office.

Basic call handling features, such as hold, transfer and call forward.

Call coverage to IP Office Voicemail Pro and Message Waiting Indicator (MWI)
activation/deactivation.

Voicemail navigation and DTMF transmission using RFC 2833.

2.2. Test Results

Basic Remote Worker functionality was successfully verified with the following observations
and limitations.

SRTP media in Avaya Flare® Experience for Windows — Avaya Flare® Experience
for Windows Release 1.1.4.23 supports SRTP media encryption for audio calls only.
Enabling Video in the softphone Settings/Video tab effectively changes the media
encryption in the client from SRTP to RTP for all calls. During the test, Video was left
disabled on the Avaya Flare® Remote Workers clients, and SRTP encryption was used
for audio calls.

SRTP media in Avaya IP Office 9.0 — Avaya IP Office release 9.0 does not support
direct SRTP connections on its interfaces. The Avaya SBCE was used to convert the
SRTP media encryption used for the external connections to the Avaya Flare®
Experience for Windows users, to RTP media in the internal enterprise network to the IP
Office.

2.3. Support

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com.
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3. Reference Configuration
Figure 1 illustrates the sample configuration used to test the Remote Workers functionality.
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Figure 1: Test Configuration

Note that for security purposes, all public IP addresses shown throughout these Application
Notes have been edited so the actual values are not revealed.
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The main components used to create the simulated Enterprise and Remote Workers sites used
during the test included:

e Avaya IP Office 9.0 Server Edition solution.
e Avaya Session Border Controller for Enterprise 6.3.

e Various endpoints including Avaya 96x1 IP telephones (H.323), Avaya 1140E SIP
telephones, Avaya 9508D Digital Telephones and analog telephones at the enterprise site.

e Avaya Flare® Experience for Windows and Avaya one-X® Mobile Preferred for IP
Office (for 10S and Android) at the Remote Workers site.

e DNS Server.

The Avaya IP Office Server Edition solution at the enterprise site comprises the following main
components:

e |P Office Server Edition Primary server.
e |P Office Server Edition Expansion System (V2)

The IP Office Server Edition Primary server consists of a HP Proliant DL360 server. The
Primary server provides the IP Office Server Edition software, Avaya one-X® Portal and Avaya
Voicemail Pro. The server is the only component required to support IP endpoints and SIP
trunking. The LANL1 port of the Primary Server (Eth0) is connected to the enterprise LAN. The
LAN2 port (Eth1) was not used during the compliance test.

The optional Expansion System (V2) is used for the support of digital, analog and additional IP
stations at the enterprise. It consists of an Avaya IP Office 500v2 with analog and digital
extension expansion modules, as well as a VCM64 (Voice Compression Module). The LAN1
port of the Avaya IP Office IP500V2 is connected to the enterprise LAN. LAN2 was not used.

Located at the edge of the enterprise, the Avaya SBCE has two physical interfaces. Interface B1
was used to connect to the public network, while interface Al was used to connect to the private
enterprise infrastructure. All signaling and media traffic entering or leaving the enterprise flows
through the Avaya SBCE, in this way protecting the enterprise against any SIP-based attacks.
The Avaya SBCE also performs network address translation at both the IP and SIP layers.

Avaya Flare® Experience for Windows and Avaya one-X® Mobile Preferred for IP Office (for
IOS and Android) are used in the sample configuration as Remote Workers. The Remote
Workers Wi-Fi and Internet access is provided by a wireless Router/NAT/Firewall located at the
Remote Worker site. The router also provides DHCP service to the local SIP endpoints.

The Avaya one-X® Mobile Preferred VVolP clients used during the test required the Fully
Qualified Domain Name (FQDN) of the Avaya one-X® Portal server (or the router fronting it) to
be entered on the Server ID field of the client settings screen. On a real customer deployment,
this FQDN should be resolvable over the public Internet. For testing purposes, and since a
private FQDN was used in the lab environment, the router at the Remote Workers site was
configured to use one of the external IP addresses of the Avaya SBCE (172.16.157.161) as its
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DNS server. The Avaya SBCE relayed DNS traffic to an internal DNS server (192.168.10.100)
at the enterprise. This internal DNS server was configured to provide the proper external IP
address information based on the type of service requested by the Avaya one-X® Mobile client.

The table below summarizes the encryption capabilities, at the time of writing these Application
Notes, of the VoIP clients supported as Remote Workers with Avaya IP Office release 9.0 and
Avaya SBCE 6.3,. Note that Avaya Flare® Experience for IPad was not part of the reference
configuration and it was not tested.

TLS SRTP Audio SRTP Video
Flare Experience Yes Yes No
for IP Office R1.1.4
(Windows version)
Flare Experience Yes Yes No
for IP Office R1.1.2
(iPad version)
one-X Mobile Yes No No
Preferred VolP
client for Android
one-X Mobile No No No
Preferred VoIP
client for i0OS

Table 1: Supported clients and capabilities

In the reference configuration, the following transport protocols were used between the Avaya
SBCE and the Remote Workers over the simulated public network:

e Auvaya Flare® Experience for Windows: TLS/SRTP
e Avaya one-X® Mobile Preferred for IP Office (Android): TLS/RTP
e Avaya one-X® Mobile Preferred for IP Office (I0S): TCP/RTP

The transport protocol used between the Avaya SBCE and the IP Office Primary Server across
the private enterprise network was TCP/RTP.

Note: The intent behind these Application Notes is to simply illustrate a sample configuration
and provide a general guide in the provisioning steps that are required in order to support Remote
Workers on an Avaya IP Office solution and the Avaya SBCE. The settings presented here are
based on the reference configuration are not intended to be prescriptive. Remote Worker
integration with SIP Trunking was not part of the reference configuration. Interoperability
Compliance Testing of Remote Worker endpoints with SIP Trunking should be performed
separately with each Service Provider. Testing of additional supported Remote Worker SIP
endpoints, not listed under Section 4 in this document, is outside the scope of these Application
Notes.
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4. Equipment and Software Validated
The following Avaya equipment and software were used for the sample configuration provided:

Equipment/Software Release/Version
Avaya IP Office Server Edition Primary server:
e IP Office Server Edition 9.0.5.0 Build 972
e Avaya one-X® Portal 9.0.5.0. Build 5
e \oicemail Pro 9.0.5.0. Build 4

Avaya IP Office Server Edition Expansion
System (V2):

e Avaya IP 500 V2 9.0.500.972
e Avaya IP Office Digital Expansion 9.0.500.972
Module DCPx16
Avaya IP Office Manager 9.0.5.0.Build 972
Avaya Session Border Controller for Enterprise | 6.3.000-19-4338
Avaya 9640 IP Telephone (H.323) Avaya one-X® Deskphone Edition
3.2

Avaya 1140E IP Telephone (SIP) 04.04.14.00
Avaya Digital Phone 9508 0.55

Avaya one-X® Mobile Preferred for IP Office 1.9.0.9900 (Android 4.4.2)
(Android)
Avaya one-X® Mobile Preferred for IP Office 8.1.2.599 (10S 8.1.2)
(10S)
Avaya Flare® Experience for IP Office 1.1.4.23
(Windows)

Table 2: Hardware and Software Components Tested.
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5. Configure IP Office

This section describes the Avaya IP Office configuration necessary to support Remote Workers.
Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the
PC running IP Office Manager, select Start > Programs - IP Office > Manager to launch
the application. Navigate to File > Open Configuration (not shown), select the proper Avaya
IP Office system from the pop-up window, and log in using the appropriate credentials.

B SelectIP Office [= = [ =]
Harme IP Add.. Type Wersion Edition
Server Edition 8.0
Primary 10.5.5.90 IPO-Linux-PC 9.0.5.0 build 972 Server (Primary)

Configuration Service User Login

IP Office: Primary - IPO-Linux-PC

Service User Mame |

Service User Password

TCP Discovery Pragress

Unit/Broadcast Address

On Server Edition systems, the Solution View screen will appear, similar to the one shown
below. This screen includes the system inventory of the Primary and Expansion systems in the
solution. In the reference configuration the Remote Workers users registered to the Primary
server, hence all the configuration steps shown were performed on the Primary server. Clicking
the “plus” sign next to Primary on the left navigation pane will expand the menu on this server.

Configuration ‘ = Server Edition

=-R BOOTP (3)
Operator (3)

Summary Open... =

(=557 Solution
@ Userill)
u Group(0)
B Short Codeid6)
e Incoming Call Route(3)
-5 Directory(0)
-4 Time Profile (D)
-l Account Codedl)
§5 User Rightsi®)
B Location(l)
57 Primary
5 Expansion

_ Fener Eation Frmary

@ Configuration
:i Svystem Status

= Hardware Installed
Cantrol Unit IPO-Linuz=PC
Secondary Serer. NOME
Expansion Systerns: 10.5.5.91
Systern [dentification: h58h88afd20891825abf00a467 3f0ce5ed2c7 200
Serial Mumber: ac162dbb 236
= Systemn Settings
IP Address: 10.5.5.90
Sub-Met Mask: 265.265.255.0
Systern Locale: United States (LS Enalish)
Device ID: NOME
Mumber of Extensions on System: 5

Description Name Address  Primary Link  Users Configured Extens
Solution " "
Primary Server Primary 105590 ] 5
Expansion Systern Expansion 105591 Bothway B B

A@— Wicernail Administration
@ Resilience Administration

m

L On-boarding

:‘ IP Office Web Manager

@ tew

Add...

%, Secondary Server -
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The appearance of the IP Office Manager can be customized using the View menu. In the

screens presented in this section, the View menu was configured to show the Navigation pane on
the left side and the Details pane on the right side. These panes will be referenced throughout the
Avaya IP Office configuration.

Standard feature configurations that are not directly related to the interfacing with the Remote
Workers are assumed to be already in place, and they are not part of these Application Notes.

5.1. Licensing

The configuration and features described in these Application Notes require the IP Office system
to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

Navigate to Solution = Primary - License on the left Navigation pane. Verify that there is a
valid Power User license with sufficient instances for the amount of Remote Workers to be
supported.

Configuration

]

2-R BOOTP (3)
t-4 Operator (3
5 Solution

@ Userilly

1{! Groupil)
+-@% Short Codei46)

License | Rernote Server

License Mode  License Normal

PLDSHostID 66271 S

- Incoming Call Route(3) Feature License Key Instances Status Expiry Date Source
-4 Directory(l) Wiave User yHhAS eSO CTctoghsc3bFL, 255 Walid MHewer ADIMadal
(-“ Tirne Profile{l) Receptionist THnBG4dpte CtMBUCKckc8TLD.., 255 Walid MHewer ADIMadal
8 Account Code(0) Preferred Edition Additional Voice.. s¥OOdzL¥¥ddnyMzMCTeorBbr.. 235 Walid Mewer ADIModal
+§5 t';s;;"oi"(tus)(s) 31 Party [P Endpoints VDM g_VGELXMBCBRevgni0... 255 walid Never ADTNodsl
-9 Primary SIP Trunk Channels Mz 15QavhHgm TR gL ORsr.. 255 “Walid Mewer ADIMadal
+. Systerm (1) IP500 Universal PRI (Additional cha.., DhztltrceA80nSRafquidgxvd., 253 Walid Mewer ADIModal
f---T". Line ($) UMSE Web Services 0 THA9RX dECOMWE WMo RgrL.., 255 Walid Fewver ADIModal
G- Contral Unit {5) Byaya P endpaints Z4msKDorsGOb@AkRpxbeEgs.., 255 Walid Mewer A0 Madal
#-4 Extension (5) [[PowerTser TEQGAgb VG INDEQSAckadzZLL.., 235 ald Mewer ED1 Modal
: E:ELS)(D) Office Warker rozerDoPHUBRhmy IWSUECS a0 255 Vald Hewer DL Hodal
+“ Short Code (3) WhAPro TTS Professional AyD2LzhovGLHRKEZW Ceonc 4T, 255 alid Mewer ADIModal
@ Service (0} Server Edition 0XQdswhbtspodhdneSierHlicrgd., 255 Walid Mewer ADIMaodal
+II IP Route (1) Server Edition Upgrade 255 @OLbyOtSFHNEZRCle_loicsh., 1 Walid Mewer ADIModal
- [T CTILink Pra BOL1D0L b COEW/ gexgrGTVEK:,.. 235 Valid Mever ADI Madal
E:'; 'Ii‘fcsagin (U) Server Edition Upgrade 10 255 chacllg¥hXCSd_DUYQMOBwhai., 10 Walid Mewer ADIModal
% Expansion Preferred Edition Additional Vaoice...  Virtual Additional Voicemail Pra ... 22 “Walid Mewer YWirtual
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5.2. LAN Settings

In the sample configuration, the LAN1 port was used to connect the IP Office to the enterprise
network. Navigate to Solution - Primary - System (1) in the left Navigation pane and select
the LAN1 - LAN Settings tab in the Details pane. Set the IP Address and IP Mask fields to

the IP address and subnet mask assigned to the Avaya IP Office LAN1 port. All other parameters
should be set according to customer requirements.

Configuration | = Primary

+x BOOTR (3) Systern | LAML | LAMNZ | DMS Woicemail | Telephony | Directory Services | Systern Events | SMTP | SMDR | Twinning
#-47 Operator (3)
;---"-3 Solution LAM Settings | 4ol Metwark Topology

+-§  User(ll)

i Group(0) IP Address 10 5 5 a0

+-@% Shart Codeid6)

+-{ Incoming Call Route(3) IP Mask 255 35 35 0

-2 Directone(l)
£ Time Profile(0)

----- & Account Code(l) Mumber Of DHCP IP Addresses |1 =
J:r---ﬂ‘, User Rights(8)
----- & Location () DHCP Maode

Prirnary
Systern (1)
; Bl Primary
+-F7 Line (4)

Sercer Client @ Disabled Advanced

On the VolIP tab in the Details pane, the H323 Gatekeeper Enable box is checked to allow the
use of Avaya IP Telephones with the H.323 protocol. The SIP Trunks Enable box must be
checked if SIP trunks are to be configured on this interface. Check the SIP Registrar Enable
box to allow the registration of the SIP Remote Workers users, as well as the Avaya 1140E SIP
Telephones present in the enterprise network in the sample configuration. On the Domain Name
field, the local SIP registrar domain name sil.miami.avaya.com was used. On the Layer 4
Protocol section, the default UDP and TCP protocols and ports were used. TLS was enabled,
for the correct provisioning of the one-X® Mobile Android clients via one-X Portal. Defaults
were used in the reference configuration for the rest of the LANL1 settings.

LAM Settings | WoIP Metwark Topaology

V| H323 Gatekeeper Enable

Auyto-create Exn Buto-create User | H323 Remote Extn Enable
| SIP Trunks Enable

| SIP Reqistrar Enable

Auto-create Extn/User SIP Rermote Extn Enable
Domain Mame sil.rniammiavaya.corm
J] UDP UDP Port 506D = Rermate UDP Port | 5060
Layer 4 Protacal V| TCP TCP Part 3060 = Rernote TCP Port 3060
| TLS TLSPort 3061 = Rermote TLS Port 5061
Challenge Expiry Tirne (secs) 10 s

RTP
Port Mumber Range

Minimum 49152 = Maxirnurm 53246 :

Paort Number Range (NAT)

Minirmurm 49132 = Maximum 33246 =
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5.3. Users

Navigate to Solution > Primary - Users in the left Navigation pane. Right click on Users and

select New (not shown) to configure the Remote Workers users.

Enter the Name, Password and Extension number. Under Profile, select Power User. For the
Avaya Flare® Experience for Windows Remote Worker user, check the box under Enable
Softphone. Select the Enable one-X Portal Services check box only if the extension is to be
granted access to the Avaya one-X® Portal user page. Select Enable Flare. The screen below
shows the User tab for one of the Avaya Flare® Experience for Windows Remote Workers,
“Flare SIP 4006 in the reference configuration.

Configuration

Flare SIP 4006: 4006

§  Userii1)

..... $ Group(D)

(8% Short Code(46)

(-4 Incoming Call Route(3)
@& Directory(0)
71 Time Profile(0)

----- B Account Code(l)

-fq User Rights(8)

""" & Location(D)

Primary

%29 System (1)

9 Line (4)

=+ Control Unit (5)
t-- 4 Extension (5)
-§  User (6)

[

=l IP Route (1)
% License (16)
- ARS (1)
""" & Location (0)
[#-%37 Expansion

User Voicemail | DMD | Short Codes | Source Mumbers | Telephony | Forwarding | Dial In |‘u’oice Recording | Button Programming

Mame

Password
Confirm Password
Account Status
Full Mame
Extension

Email Address
Locale

Priority

System Phone Rights
ACCS Agent Type

Profile

Flare SIP 4006

Enabled

4006

[

5

[None

MNone

[ Power User

[] Receptionist

Enable Softphone

Enable one-X Portal Services
[] Enable one-X TeleCommuter
[] Enable Remaote Worker
Enable Flare

[] Enable Mohbile VoIP Client

Navigate to the user Telephony - Supervisor Settings tab. Enter the Login Code used by the
endpoint to register. The same code used in the Password field was entered. Click OK (not
shown) to save your changes.

Flare SIP 4006: 4006

| User | Voicemail | DMD | Short Codesl Source Numbers| Telephany |Forwarding | Cial In | Voice Recording | Button Prog

Legin Code

Moniter Group

Legin Idle Period (secs)

Call Settings Superviianettings|Mu|ti_|ineoption5|Ca”LongUI |

<MNone>

[7] Force Login

[7] Force Account Code
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Repeat the previous steps to configure the Name, Password, Extension number, Profile and
Login Code for the Avaya one-X® Mobile Preferred for IP Office users.

On the User tab, check the box under Enable Softphone. Select the Enable one-X Portal
Services check box only if the extension is to be granted access to the Avaya one-X Portal user
page. Select Enable Mobile VolP Client.

The screen below shows the User tab for one of the Avaya one-X® Mobile Preferred for IP
Office Remote Workers, “SIP4002” in the reference configuration.

Configuration | = SIP4002: 4002
‘s BOOTP (3) User |Voicemai| | DND | Short Codes | Source Numbers | Telephony | Forwarding | Dial In |Voice Recording | Button Programming
4% Operator (3)
[=1-*%=¢ Solution Name SIP4002
E-§  User(11)
""" 3% Group(0) Password e
(8% Short Code(46)
(-3 Incoming Call Route(3) Confirm Password eeee
----- @x Directory(0)
7 Time Profile(0) Account Status Enabled -
: Account Code(0)
-§3 User Rights(8) Full Name
5% Location({) Extension 4002
-7 Primary
(-5 System (1) Email Address
-9 Line (4)
&= Contral Unit (5) Locale [ -]
(-4 Extension (3) o
E—& User (6) Prierity [5 V]
fnd 2 Mol
400015;;4001 Systern Phone Rights ’None v]
@ 4006 Flare SIP 4006
ACCS Agent T MNone
o 1002 SIP4002 gent Type
ﬂ" 4010 5IP4010 Profile ’Power User v]
e 4005 Soft H323 4005
ﬂ Group () =] Receptionist
(@ Short Code (3) Enable Softoh
@ Service (0) [¥] Enable So phone
(- Jill IP Route (1) Enable one-X Portal Services
-- W License (16)
B¢ ARS (1) [] Enable one-X TeleCommuter
- Location (0) [] Enable Remote Worker
[#-%27 Expansion
[] Enable Flare
Enable Mobile VoIP Client
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5.4. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top left of the screen to save the
configuration performed in the preceding sections. A screen like the one shown below is
displayed, showing details for those systems where the system configuration has been changed
and needs to be sent back to the system. Reboot or Merge is shown under the Change Mode
column, based on the nature of the configuration changes made since the last save. Note that
clicking OK may cause a service disruption. Click OK to save the configuration.

™ Send Multiple Configurations EI@
. Change . Incoming Outgoing Error
Selectipligetiice Mode Rebactline Call Barring Call Barring Status Ricoress
3 Primary Merge - | 8:25 Am A |
QK l ‘ Cancel ‘ ‘ Help
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6. Configure Avaya one-X® Portal for IP Office

The Avaya one-X® Mobile Preferred clients communicate with Avaya one-X® Portal to
determine the feature and extension configuration. In the lab environment used to verify the
remote workers functionality, an IP Office Server Edition was used, where Avaya one-X® Portal
runs as a service on the Primary server. In other configurations, Avaya one-X® Portal may run
on a separate server as part of the Avaya Application Server.

It is assumed that the installation and initial configuration of Avaya one-X® Portal has been
completed and it is not discussed in this document. For more information consult the Avaya one-
X® Portal documentation in the References section.

6.1. Avaya one-X® Portal Log in

The Avaya one-X® Portal configuration is accomplished by pointing a browser to the URL
“http://<server name>:<server port>/onexportal-admin.html”, where <server name> is the name
or the IP address of the one-X Portal server, and <server port> is the port number selected during
one-X Portal for IP Office software installation (the default is 8080). The one-X Portal for IP
Office login menu appears. Click on Administrator Login at the top of the screen. Enter the
appropriate credentials and click on Login.

AVA A ol Version: 8.0.5.0
- |‘ 122\

TS

User name

Password
Language English~
Remember me on this computer

P Login to phone

[ [ogin
Change Password
© 2014 Avaya Inc. All Rights Reserved.
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The following screen is presented:

AVAYA

Health
Component Status
Kew Recent Events

Active Sessions
Enuironmert

Configuration
Diagnostics

Directory Integration
Gadagets Confiquration

IM/Presence server status

=2 Portal for IP Office

®

elcoms Administrator | Helo | Logout | Wersion: 3

W Comporent Status
P Description: Heath of key one-x Portal for IP Office components

Get All

3“’""3"»&” records have been retrisved

o Component Name Status Reported At Adiditional Info. Page 1
M [34 [ceTAProvider1-10.5.5.50 I | - = 2014 4:39:50 M [Provider OK Delete
[ [33 [caTa-Provider1-Master I |- 5 20020950 P [Master Avalable Delcte

@ 3 ‘DSML—F’mvider—1—10.5.5.90

B[ [osMCProvder -idap dap-zerver- N | J=r 11, 2014 5:45:13 PM |

P IMiPresence server status
P Key Recent Everts
P Antive Sessions

I | - c. 2005 555,55 P [Global resynchroniz [_Delete
Delete

P Enwironmert

6.2. Configure XMPP Domain

Use this procedure to configure or change the XMPP Domain Name of Avaya one-X® Portal.
The XMPP Domain Name, entered as a Fully Qualified Domain Name (FQDN), is entered by
the Avaya one-X® Mobile Preferred clients in the Server ID field of the client settings screen in
order to register with the IP Office, later in Section 10.

From the left hand side navigation menu, select Configuration - IM/Presence. Verify or enter
the one-X Portal FQDN in the XMPP Domain Name field. In the reference configuration,
iposerver.sil.miami.avaya.com was used. Click Save. The system displays another dialog box to
restart Avaya one-X® Portal (not shown). Restart the server.

Eranditig

DAY .
oi=>< Portal for IP Office
Health P Providers

Providers | =

Users X

oay P Eranding

IfPresence |
wChande Serice

V¥ IM/Presence Server

Server to Server Federation
Dizconmect an ldle D
Aryone can connect
Paort purnber

Idle timeowt 3600

Iy Buddy username

Diagnostics

Directory Integration
Gadgetz Configuration
IM Archive

Help & Support

*MPP Domain Name iposerver. sil.miami.avaya. |

. Save |

P IMiPresence Exchange Service
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7. Configure Avaya Session Border Controller for Enterprise

This section describes the configuration of the Avaya SBCE to support the Remote Workers. It is
assumed that the initial provisioning of the Avaya SBCE, including the assignment of the
management interface IP Address and license installation have already been completed; hence
these tasks are not covered in these Application Notes. For more information on the installation
and provisioning of the Avaya SBCE consult the Avaya SBCE documentation in the Additional
References section.

7.1. System Access

Access the Session Border Controller web management interface by using a web browser and
entering the URL https://<ip-address>, where <ip-address> is the management IP address
configured at installation. Log in using the appropriate credentials.

Log In
AVAYA =
Password -

Session Border Controller This system s restricted solsly to suthorized users for legiimate
for Enterprise bu = only. The actusl or attempted unathori s,

s of this system is strictly profibited. L

0 o inary procedures an al
and civil penatliss uncer state, fecieral or other applicalle domestic and
foreign laws

The use of this system may ke montored and recorced for
administrative and security reasons. Anyone accessing this system
expressly canserts to such mantoring and recording, and is atvised
thet if it revesls possible evidence of criminal activty, the evidence of
such activity may be provided to law enforcement officials

Al users must comply with el corporate instructions regarding the
protection of information assets.

@2011 - 2013 Avaya Inc. Al rights reserved.

Once logged in, the Dashboard screen is presented. The left navigation pane contains the
different available menu items used for the configuration of the Avaya SBCE. New in release 6.3
of the Avaya SBCE is the License State field. In the example below, the status OK indicates
that a valid license is present.

Alarms ncidents | Status ~  Logs ~  Diagnostics  Users Seftings ~  Help~  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard System Time 11:37:53 AM EST Refesh  EMS |
Adrinistration " R

Brsion -13-,
Backup/Restore et SEIE
System Management Build Date Fri Sap 26 (9-1423 EOT 2014
> Global Parameters License State 9 0K
» Global Profiles Aggregate Licensing Overages 0

» PPM Services
> Domain Palicies

Peak Licensing Overage Count 0

> TLS Management

(past 24 hours)

> Device Specific Settings Mone found Micro_SBCE: Target is neither a server nor a subscriber, Sending 403
Forbidden

Micra_SBCE: Target is neither a server nor a subscriber, Sending 403
Forhidden

Al

Mo notes found

Ll
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7.2. System Management

To view current system information, select System Management on the left navigation pane. A
list of installed devices is shown in the Devices tab on the right pane. In the reference
configuration, a single device named Micro_SBCE is shown. The management IP address that
was configured during installation is shown here. Note that the management IP address needs to
be on a subnet separate from the ones used in all other interfaces of the Avaya SBCE, segmented
from all VVolIP traffic. Verify that the Status is Commissioned, indicating that the initial
installation process of the device has been previously completed, as shown on the screen below.

Session Border Controller for Enterprise AVAYA

Dashboard System Management
Adrninistration

Backup/Restore
[ sst vpn | [ Licensing

Devices || Updates

Bystem Management
e
> Global Profiles 5.3.000

) Micra_SBCE 192.168.10.75 19 Commisgioned  Rebool  Shutdown  Restart Application Edit  Uninstall
» PPM Services 4338

> Domain Policies

arameters Device Mame hManagement P Version Status

> TLS Management

> Device Specific Settings

To view the network configuration assigned to the Avaya SBCE, click View on the screen
above. The System Information window is displayed, as shown on the screen on the next page,
containing the current device configuration and network settings.

MAA,; Reviewed: Solution & Interoperability Test Lab Application Notes 17 of 51
SPOC 2/17/2015 ©2015 Avaya Inc. All Rights Reserved. RemW_IPO9SBCEG3



Note that the Al and B1 interfaces correspond to the private and public interfaces for the Avaya
SBCE. In the reference configuration, Remote Workers support was deployed on the same
Avaya SBCE already provisioned for SIP trunking, but adding separate IP addresses. The
highlighted Al and B1 IP addresses are the ones relevant to these Application Notes. Other IP
addresses assigned to these interfaces on the screen below are used to support SIP trunking and
they are not discussed in this document. On the License Allocation area of the System
Information, verify that there are sufficient Standard and Advanced Sessions to support the
desired number of simultaneous Remote Workers sessions. The number of sessions and
encryption features are primarily controlled by the license file installed.

System Information: Micro_SBCE X

General Configuration Device Configuration License Allocation

Appliance Mame Iicro_SBCE H& Mode Mo Standard Sessions =00
Fequested: 00

Box Type SIP Two Bypass Mode  ho _
Advanced Sessions 100
F: sted: 100

Deployment Made  Prowxy =quesie

Soopia Widen Sessions  qgg
Fequested: 100

Encryption

r Hetwork Configuration
Puhlic IP Metmask Interface
1055152 1055152 29525352550 10.5.5.254 &1
1055153 1055133 29525352550 10.5.5.254 &1
17216157 189 17216157189 255255 255192 17246157128 B1
17216157 160 172.16.157 160 255255255192 172.16.157 128 B1
17216157 161 172.16.157 161 255255 255192 172.16.157.128 B1
r DHS Configuration Management IP(s)
Primary DS 192168216122 P 192 165.10.75
Secondary DNS 192,168.153.242
DME Location Dz
DNS Client IP 172.16.157 189
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7.3. Network Management

Select Network Management under Device Specific Settings on the left-side menu to enter or
to verify the network configuration parameters assigned to the Avaya SBCE interfaces.

Under Devices in the center pane, select the device being managed, Micro_SBCE in the sample
configuration. On the Networks tab, click Add or Edit to enter or to modify the network
information as needed. Note that the Al and B1 interfaces correspond to the private and public
interfaces for the Avaya SBCE.

The following Avaya SBCE IP addresses and associated interfaces were used in the reference
configuration:

e Al:10.5.5.152 — “Private” address previously configured for SIP trunking. This address
is not relevant to the Remote Workers functionality and is not discussed in this document.

e Al1:10.5.5.153 — New “private” address added for Remote Workers access to the
enterprise private network.

e B1:172.16.157.189 — “Public” address previously configured for SIP trunking. This
address is not relevant to the Remote Workers functionality and is not discussed in this
document.

e 172.16.157.160 - New “public” address added for Remote Worker SIP traffic. Remote
Worker SIP endpoints will use this “public” address to established connection to the IP
Office through the Avaya SBCE for registration and telephony functions.

e 172.16.157.161 - New “public” address added for Remote Worker DNS and XMPP (one-
X Portal) traffic. The Avaya SBCE relayed DNS traffic received from Avaya one-X®
Mobile clients to an internal DNS server at the enterprise. This internal DNS server was
configured to return the proper external IP address information based on the type of
service requested by the Avaya one-X® Mobile client.

Session Border Controller for Enterprise AVAYA

Dashhoard = Network Management: Micro_SBCE

Administration
Interfaces Networks

Micro_SBCE o

Backup/Restore

Systern Management

> Global Parameters

+ Global Profiles Marne Gateway Subnet Mask Interface IP Address

» PPM Services 10.5.5.152,

. Dormain Policies Metwiork_Al 1055254 285 2552550 Al 1055153 Edit  Delete
+ TLS Management 172.16.157 189,
Metwork_B1 17216 157 129 255 256 255192 B 17216 157 160,  Edit  Delete
4 Device Specific Setings 172.16.157.161
Network
Management
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7.4. Relay Services

IP Office Remote Worker best practices recommend that all traffic that is not SIP or media
related (DNS, XMPP, etc.) should be forwarded directly from the endpoints to the required
service through the enterprise firewall, and not through the Avaya SBCE. In the test
environment, a firewall was not available between the simulated remote site and the IP Office
location. The Relay Services feature of the Avaya SBCE was used to perform port forwarding
capabilities normally done by the firewall.

Navigate to Device Specific Settings = DMZ Services = Relay Services and click Add to
configure the application relays rules. The following screen shows the application relays needed
in the sample configuration to allow all the necessary traffic to be routed to the appropriate
internal servers.

The Application Relay named DNS was configured to relay DNS queries and responses on UDP
port 53 between the Avaya one-X® Mobile Preferred VolIP clients and the enterprise DNS
server. The Remote IP:Port was set to 192.168.10.100, the IP address of the internal DNS
server. The Listen IP:Port was set to the IP address and port of the Avaya SBCE’s external IP
address designated for application relay (172.16.157.161) . The Connected IP was set to the
internal IP address of the Avaya SBCE used for Remote Workers (10.5.5.153).

The Application Relays named OneXP1 and OneXP2 were created to relay XMPP traffic on
TCP ports 5222 and 8444 between the Avaya one-X® Mobile Preferred VoIP clients and Avaya
one-X Portal. The Remote IP:Port was set in this case to the IP address of the internal Avaya
one-X Portal server (10.5.5.90), which runs on the IP Office Primary server. Similarly,
Application Relays OneXP3 and OneXP4 were created to relay XMPP traffic on TCP ports
8063 and 9443 between the Avaya Flare® Experience VolIP clients and Avaya one-X® Portal.

Session Border Controller for Enterprise AVAYA
> Global Profiles A Relay Services: Micro_SBCE
> PPM Services
» Domain Policies
m Application Relay ‘ ‘ File Transfer ‘ ‘ Reverse Proxy
» TLS Management
B - Micro_SBCE
4 Device Specific Settings Add
Network Name Type Remote Domain Remote IP-Port Remote Published Domain Listen IP-Port Listen Connect IP
Management Transport Transport
Media Interface OneXP1 XMPP  sil miamiavayacom 105580:56222 TCP sil miami avaya.com  172.16.157.161:5222 TCP 1055153 View
Signaling Interface DNS LDAP  silmiami.avaya.com 192.168.10.100:53 UDP silmiami.avaya.com 172.16.157.161:53  UDP 10.55.153  View
End Point Flows OneXP2 XMPP  silmiamiavaya.com 10.55.30:8444 TCP sil. miami avaya.com  172.16.157.161:8444 TCP 1055153 View
Session Flows
OneXP3 XMPP  silmiamiavaya.com 10.5590:8063 TCP sil miami avaya com  172.16157.161:8063 TCP 1055.153  View
4 DMZ Services
Relay OnexXP4 XMPP  silmiamiavaya.com 10.5590:9443 TCcP sil miami avaya.com 172.16.157.161:9443 TCP 1055153 View
Services < >
Firewall
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7.5. User Agents

User Agents were created for the different endpoints tested. This allows for different policies to
be applied based on the type of device being used. For example, Avaya Flare remote workers

used SRTP for the media, while one-X® Mobile remote workers used RTP.

Navigate to Global Parameters - User Agents and click Add to configure the User Agents.
The following screen shows the User Agents created in the reference configuration. The Regular
Expression field is used to match the information contained on the User-Agent header arriving
from the endpoint. The “.*” in the expression is used to match any character string after the user

agent name.

Dashhoard
Administration
Backup/Restore
Systemn Management
4 Global Parameters

-

m

User Agents

User Agents

Session Border Controller for Enterprise

AVAYA

RADIUS MName Regular Expression
DoS / DDas Avaya Flare Avaya Flare.™ Edit  Delete
Scruhber .
Avaya one ¥ Mobile Avaya One X Maobile.™ Edit Delete
> Glabal F’rufilesm
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7.6. Media Interfaces

Media Interfaces were created to specify the IP address and port range in which the Avaya SBCE
will accept media streams on each interface.

To add the Media Interface in the enterprise direction, select Media Interface from the Device
Specific Settings menu on the left-hand side, select the Micro_SBCE device and click the Add
button (not shown). On the Add Media Interface screen, enter an appropriate Name for the
Media Interface. Select the private IP Address for the Avaya SBCE used for Remote Workers
from the 1P Address drop-down menu. The Port Range was left at the default values of 35000-
40000. Click Finish.

Add Media Interface X

Marne Biy_Private_media

IP Address 1055183 [+]

Port Range 35000 - 40000
Finigh

A Media Interface facing the public network side was similarly created. The outside IP Address
of the Avaya SBCE used for Remote Worker SIP traffic was selected from the drop-down menu.
The Port Range was left at the default values. Click Finish.

Add Media Interface X

Mame BEW_Puklic_media
IP Address 172.16.157.160 |~ |
Port Range 35000 - 40000
Finish
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7.7. Signaling Interfaces

Signaling Interfaces are created to specify the IP addresses and ports in which the Avaya SBCE
will listen for signaling traffic in the connected networks.

To add the Signaling Interface in the enterprise direction, select Signaling Interface from the
Device Specific Settings menu on the left-hand side, select the Micro_SBCE device and click
the Add button (not shown). On the Add Signaling Interface screen, enter an appropriate Name
for the interface. Select the private IP Address of the Avaya SBCE used for Remote Workers
from the 1P Address drop-down menu. Enter 5060 for TCP Port, since TCP port 5060 was used
to listen for Remote Worker signaling traffic from the IP Office in the sample configuration.
Click Finish.

Add Signaling Interface X

Mame Ry _Private_sig
IP Address 1055153 [+]
TCF Part
Leawve blank to dizable 5080
UDP Port
Leawve blank to dizable
TLS Port
Leawve blank to dizable
TLS Profile Mone

Enable Shared Contral

Shared Contral Port

Finish
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A Signaling Interface facing the public network side was similarly created. The outside IP
Address of the Avaya SBCE used for Remote Worker SIP traffic was selected from the drop-
down menu. In the public network direction, both TCP Port 5060 and TLS Port 5061 were
used. Select AvayaSBCServer from the TLS Profile drop down menu. Click Finish.

Add Signaling Interface X

Marme Fi_Public_sig

IP Address 172.16.157.160 IZ|

TCP Port

Leawe blank to dizable 5080

UDP Part

Leave blank to dizable

TLS Fort

Leawve blank to dizable 5081
TLS Profile AvayaSElCSeNerE
Enable Shared Control ]

Shared Control Port

7.8. Server Interworking

Interworking profiles can be created by cloning one of the pre-defined default profiles, or by
adding a new profile. In the reference configuration, a profile named IP Office was created by
cloning the default avaya-ru interworking profile.

To configure the interworking profile for the IP Office, select Global Profiles > Server
Interworking on the left navigation pane. Under Interworking Profiles, select avaya-ru from
the list of pre-defined profiles. Click Clone.

Dashhoard
Administration
Backup/Restare
Systemn Management

|»

Interworking Profiles: avaya-ru

It is not recommended to edit the defaults. Try cloning or adding a n file instead.

» Global Paramsters General | Timers | ‘ URI Manipulation | ‘ Header Manipulation || Advanced
4 (Global Profiles avaya-ru - ‘ =
Genera
Darmain DoS y .
! . ©OCS-Edge-Server Hold Support NONE
Fingerprint
Server clECo-cEm 180 Handling hone
Interworking cups 181 Handling MNone -
Phone Interworking OCS-FrontEnd-Sar 182 Handing _—
Media Forking
IP Office 183 Handling Mone

Routing
Server Configuration Service Provider Refer Handling No
Topology Hiding LRI Group hane
Signaling Send Hold Mo
Manipulation
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Enter a descriptive name for the cloned profile. Click Finish.

Clone Profile

Profile MName avaya-ru

Clone Marme IIP Office
Finizh |

On the newly cloned IP Office interworking profile, verify the settings on the General tab:

General | | Timers ‘ | URI Manipulation | | Header Manipulation | | Advanced ‘
General
Hald Support MOME
180 Handling Mone
181 Handling Mone
182 Handling Mone
183 Handling Mane
Refer Handling Mo
UR| Graoug Mane
Send Hald s}
3w Handling Mo
Diversion Header Support Mo
Delayed S0P Handling Mo

Scroll down to the bottom of the tab:

General | | Timers | | URI Manipulation | | Header Manipulation | | Advanced

Re-Invite Handling Mo
T .38 Support []a]
URl Scheme SIP
“ia Header Format RFC3261

Privacy Enabled []a]
Lizer Mame
P-Asserted-ldentity Mo
P-Preferred-ldentity []u]

Privacy Header

DTMF Support Mone
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The Timers, URI Manipulation and Header Manipulation tabs contain no entries.

The Advaced tab settings are shown on the screen below:

General ‘ | Timers ‘ | URI Manipulation ‘ ‘ Header Manipulation | | Advanced |
Fecord Routes Bath
Topology Hiding: Change Call-ID Mo
Call-info MAT Mo
Change Max Forwards Yes
Include End Point IP for Context Lookup Yes
QS Extensions i}
AW AN 8 Eyvtensions ez
MORTEL Extensions Mo
Diversion Manipulation [illa]
metazwitch Extensions Mo
Rezet on Talk Spurt Mo
Reset SRTP Cortext on Session Refresh Mo
Has Remate SBC ez
Route Response on %is Port [illa]
Cizoo Extensions Mo
Edit
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7.9. Server Configuration

From the Global Profiles menu on the left-hand navigation pane, select Server Configuration
and click the Add button (not shown) to add a new profile for the Call Server. Enter an
appropriate Profile Name similar to the screen below. Click Next.

Add Server Configuration Profile

Profile Mame IF Office
Mext

On the Add Server Configuration Profile Tab select Call Server from the drop down menu for
the Server Type. On the IP Addresses / FQDN field, enter the IP address of the IP Office
LANL1, as defined in Section 5.2. Enter 5060 under Port and select TCP for Transport. Click

Next.
Add Server Configuration Profile X

Server Type Call Server E

IP Address / FQDMN Transpart
1055480 BORO TCP El Delete

l Back ] l MNext ]

Click Next on the Authentication and Heartbeat tabs (not shown). On the Advanced tab, select
IP Office from the Interworking Profile drop down menu. Click Finish.

Add Server Configuration Profile - Advanced X

Enable DoS Protection r
Enable Grooming r
Interwarking Profile |IP Office j
Signaling Manipulation Script INDne vl
Connection Type ISUEIID vl
Back | Finish |
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7.10. Routing

To create an inbound route to the IP Office, select the Routing tab from the Global Profiles
menu on the left-hand side and select Add (not shown). Enter an appropriate Profile Name
similar to the example below. Click Next.

Routing Profile

Profile Marmne To IPO from R

[t

On the Routing Profile tab, click the Add button to enter the next-hop address. Since only one
next-hop is defined, enter 1 under Priority/Weight. Under Server Configuration, select IP
Office. The Next Hop Address field will be populated with the IP address, port and protocol
defined for the IP Office Server Profile in Section 7.9. Defaults were used for all other
parameters. Click Finish.

Routing Profile X

LRI Group * |Z| Time of Day defauItE
Load Balancing Priarity |Z| MNAPTR

Transport Mone Mext Hop Priority

Mext Hop In-Dialog Bl lgnore Route Header Bl

Server Configuration Mext Hop Address Transport
1 IP Office [+] 1055305060 (TCF) [=] |[Mone Delete
| Back | | Finish |
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7.11. Media Rules

Media rules were created to specify the media encryption to be used with each type of Remote
Worker endpoint. These rules will be later applied to the End Point Policy Groups and ultimately
to the Subscriber and Server Flows, defined later in this document.

In the reference configuration, two new media rules were created, by cloning and then modifying
the default-low-med rule.

From the Domain Policies menu on the left-hand navigation pane, select Media Rules. Select
default-low-med-enc from the Media Rules list and click the Clone button.

Session Border Controller for Enterprise AVAYA
HACKURARESTOre *  Media Rules: default-low-med -
System Management
> (lobal Parameters il Fiter By Device
> Global Profiles Media Hules It is not recommended to edit the defaults. Try cloning or adding & new rule instead.
) defaultlow-med )
PPM Services 3 elaitiowsme Media NAT | | Media Encryption | | Media Silencing || Media QoS || Media BFCP | | Media FECC| -
4 Domain Policies default-love-med. . }
Application Rules . Media NAT Learn Media IP dynamically
Border Pules default-high
arcer b
Media Rules default-high-gnc P
Security Rules avaya-low-med-...
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7.11.1. Media Rule - RTP

The first media rule used RTP for media encryption. Enter an appropriate Clone Name, similar
to the screen below. Click Finish.

Clone Rule
Rule Marne default-low-rmed
Clone Mame FermWorker BTR

The screen below shows the Media Encryption tab of the cloned Rem Worker RTP rule. No
modifications were made to the defaults on this or any other tab of this media rule.

Media Encryption X

Audio Encryption
Preferred Format #1 RTF |E|
Preferred Formet #2 NONE |E|
Preferred Format #3 MOME

Encrypted RTCP
Mk

Lifetime o
Leawe blank to match any value.

Interworking

Yideo Encryption

Preferred Format #1 RTF E
Preferred Format #2 HWOME |E|
Preferred Format #3 MOME

Enciypted RTCP

[
Lifetime 24
Leawe blank to match any value.
Interworking
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7.11.2. Media Rule - SRTP

The second media rule used SRTP as the preferred format for media encryption. Repeat the
previous process to clone the default-low-med rule. Enter an appropriate Clone Name, similar to
the screen below. Click Finish.

Clone Rule
Rule MName default-low-med
Clone Mame Sem worker SRTR

On the the Media Encryption tab of the new Rem Worker SRTP rule, click Edit (not shown).
Under Audio Encrytion, select SRTP_AES CM_128 HMAC_SHAL1 80 from the Preferred
Format #1 drop down menu. Select RTP under Preferred Format #2. Verify Encrypted
RTCP is unchecked. Under Video Encrytion, make sure to leave the Preferred Format #1 as
RTP, as shown.

Audio Encryption

Preferred Format #1 SRTP_AES_Ch_128 HMALC_SHA1_30 |Z|
Preferred Format #2 RTF E
Preferred Format #3 NOME E
Encrypted RTCP ]l

Fkl |

e Wik to match any v, 2

Interworking

“ideo Encryption

Preferred Formst #1 RTF |Z|
Preferred Format #2 NOME E
Preferred Format #3 NOME

Encrypted RTCP
bkl

Lifetime 24
Leawe blank to match any walue.

Interwworking

All other parameters were left at their default values. Click Finish (not shown) to save your
changes.
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7.12. End Point Policy Groups

End Point Policy Groups associate the different sets of rules under Domain Policies (Media,
Signaling, Security, etc) to be applied to specific SIP messages traversing through the Avaya
SBCE. In the reference configuration, three different End Point Policy Groups were created.
These policy groups used default sets of rules already pre-defined in the configuration, with the
exception of the new Media Rules defined in Section 7.11.

7.12.1. End Point Policy Group — Enterprise

To create an End Point Policy Group for the enterprise, select End Point Policy Groups under
the Domain Policies menu. Select Add.

Dashboard 2! Policy Groups: default-low
Administration Add [Fitter By Device =l Clane |
Backup/Restore

Systermn Management

> Global Parameters
» Global Profiles default-low-enc

> PPM Services P— Policy Group
< Domain Palicies S
_— default-med-enc ummarny
Application Rules . Order Application Signaling
Border Rules default-high
|1— default default default-love-red default-low default Edit
Media Rules default-high-enc
Security Rules

OCS-default-high
Signaling Rules
Time of Day Rules avaya deflow-enc
End Feint Policy 1 avaya-def-high-sub
Groups

avaya-defhigh-server

Enter an appropriate name in the Group Name field. Rem Worker Inside was used. Click Next.

Policy Group

Group Marme Sem Worker Inside
MNext
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In the Policy Group tab, under the Application Rule drop down menu, default-server-low was
selected. Under Media Rule, the Rem Worker RTP media rule created in Section 7.11 was
selected. Default rules were used for all other fields as shown below. Click Finish.

Policy Group X

Application Rule default-server-low E

Barder Rule default |Z|

Media Rule Rern Worker RTP [ ]

Security Rule default-low |Z|

Signaling Rule default E
| Back | | Finish |

7.12.2. End Point Policy Group — RTP

A second End Point Policy Group with the name Rem Worker RTP was created, repeating the
steps described above. This policy group will be applied later to the Subscriber Flow
corresponding to the one-X® Mobile users. Under the Application Rule drop down menu,
default-subscriber-low was selected. Under Media Rule, the Rem Worker RTP media rule
created in Section 7.11 was selected. Default rules were used for all other fields as shown below.
Click Finish.

Policy Group X

Application Rule default-subscriber-low |Z|
Eorder Rule cefault E
Media Rule RernWorker RTP [ =]
Security Rule cefault-low E
Signaling Rule default |Z|
| Back | | Finish |
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7.12.3. End Point Policy Group - SRTP

A third End Point Policy Group with the name Rem Worker SRTP was created, repeating the
steps described above. This policy group will be applied later to the Subscriber Flow
corresponding to the Avaya Flare users. Under the Application Rule drop down menu, default-
subscriber-low was selected. Under Media Rule, the Rem Worker SRTP media rule created in
Section 7.11 was selected. Default rules were used for all other fields as shown below. Click
Finish.

Policy Group X

Application Rule default-subscriber-low E
Eorder Rule clefault E|
Media Rule e Warker SRTP [+
Security Rule default-low E
Signaling Rule default E
| Back | | Finish |
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7.13. End Point Flows

End Point Flows determine the path to be followed by the packets traversing through the Avaya
SBCE. Subscriber Flows are defined for each type of remote worker used. A Server Flow is
configured for the IP Office. These flows combine the different sets of rules and profiles
previously configured, to be applied to the SIP traffic traveling in each direction.

7.13.1. Subscriber Flow — Avaya one-X® Mobile users

Avaya one-X® Mobile remote workers clients used TCP or TLS for signaling and RTP for the
media. See Table 1 in Section 3. To create the call flow for the one-X® Mobile remote workers,
from the Device Specific menu, select End Point Flows and select the Subscriber Flows tab.
Click Add (not shown).

On the Criteria screen, enter an appropriate Flow Name. In the sample configuration one X
Mobile was used. Under User Agent, select from the drop down menu the Avaya one X Mobile
agent created in Section 7.5. Under Signaling Interface, select the signaling interface facing the
remote endpoints, RW_Public_sig, created in Section 7.7. All other fields retained their default
values. Click Next.

Add Flow X

Criteria
Flow Mame one X Mohile
LRI Group * E|
User Agent Awaya DneXMubiIeE
Source Subnet ®
Ex: 192.168.0.1/24
ia Host *
Ex: domain.com, 192 .168.0.1/24
Contact Host ®
Ex: domain.com, 192 .168.0.1/24
Signaling Interface RW_Public_sig E
[RL=P
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On the Profile screen, set the following:

e Media Interface: Select RW_Public_media. (Created in Section 7.6).
e End Point Policy Group: Select Rem Workers RTP. (Created in Section 7.12.2).
e Roting Profile: Select To IPO from RW. (Created in Section 7.10).
e Phone Interworking Profile: Select Avaya-Ru from the list of default profiles.
e TLS Client Profile: Select Avaya SBCClient.
e Leave other fields at their default values.
e Click Finish.
@ Subscriber
Source
0 Click Ta Call
INFO -
Wethods Allowed Before REGISTER EEEISF%KGE El
OPTIONS -
Media Interface Rwf_Public_media |E|
Encd Paint Palicy Graug Rem Wwoaorker RTF |E|
Routing Profile TaIPO fram Fiw |E|
Optional Setings
Topology Hiding Profile Mone |E|
Phone Intersworking Profile Avaya-Fu E
TLS Client Profile AvayaSBCClient
File Transfer Profile Mone |Z|
Signaling Manipulstion Script Mone |E|
Presence Server Address
Ex: domain.com, 192 168.0.101
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7.13.2. Subscriber Flow — Avaya Flare users

Avaya Flare remote workers clients used TLS for signaling and SRTP for the media (or RTP if
video is enabled). See Table 1 in Section 3. To create the call flow for the Avaya Flare remote
workers, from the Device Specific menu, select End Point Flows, then select the Subscriber
Flows tab. Click Add (not shown).

The screen below shows the Subscriber Flow named Flare tls-srtp in the sample configuration.
Note that User Agent is set to the Avaya Flare agent created in Section 7.5. The End Point
Policy Group is set to Rem Worker SRTP, created in Section 7.12.3.

View Flow: Flare tls-srtp X

r Criteria r Optional Settings
Flow Mame Flare tls-srtp Topology Hiding Profile Mone
LRI Group * Phone Interworking Profile Avaya-Ru
User Agent Avaya Flare TLS Client Profile AvayaSBCClient
Source Subnet * RADIUS Prafile Mane
“ia Host * File Transfer Profile Mone
Contact Host * Signaling Manipulation Script MNone
Signaling Interface  RWY_Public_sig

r Profile

Source Subscriber

Methods Allowed Before REGISTER

User Agent Avaya Flare

hWledia Interface RWW Public_media
End Point Policy Group Rem YWorker SRTF
Routing Profile To [FO from RYY

Presence Server Address
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7.13.3. Server Flow — Avaya IP Office

To create the call flow toward the enterprise, from the Device Specific menu, select End Point
Flows, then select the Server Flows tab. Click Add (not shown). The screen below shows the
flow named IPO Serv from RW created in the sample configuration. The flow uses the
interfaces, policies, and profiles defined in previous sections. Note the Routing Profile selection,
which is uses the default profile. Click Finish.

Edit Flow: IPO Serv from RW X

Flow Mame IFO Sery fram B
Server Configuration IP Office |Z|
LRI Graup * E
Transport * |Z|
Remaote Subnet *
Received Inteface Ry _Public_sig E
Signaling Interface RW_Private_sigE
Media Interface RW_Private_mediaE
End Point Policy Group Rem ‘Worker RTP E
Routing Profile default |Z|
Topology Hiding Profile Mone E
File Transfer Profile NDneE
Signaling Manipulation Script MNone E
Finish
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8. DNS Server Configuration

The Avaya one-X® Mobile Preferred VVoIP clients used during the test required a Fully Qualified
Domain Name (FQDN) to be entered on the Server ID field of the client settings screen. This
FQDN should be reachable from the public Internet. For testing purposes, since a private FQDN
was used in the lab environment, the router at the Remote Workers site was configured to use
one of the external IP addresses of the Avaya SBCE (172.16.157.161) as its DNS server. The
Avaya SBCE relayed DNS traffic to the internal DNS server (192.168.10.100) at the enterprise
via the Relay Services configured in Section 7.4.

Detailed discussion of the DNS server configuration is beyond the scope of these Application
Notes. The following screens are provided as an example illustrating the DNS settings used in
the reference configuration to respond to the DNS queries from the one-X® Mobile Preferred
clients.

The screen below shows the record for FQDN iposerver.sil.miami.avaya.com. A standard DNS
query on this FQDN will return address 172.16.157.161. This is the external Avaya SBCE
address used for Remote Worker DNS and also XMPP (one-X Portal) traffic.

=

,E" 3 iposerver 2 recordis)
E'B SERVER1L Mame  / | Twpe | Daka
EI.

| Forw?ardlLuu.:lq.lp Zones (same as parent Folder) Host (a4 172.16.157 161
EH@] =il riarmi, avaya, com bep

- [ iposerver -

F-L 1 Reverse Lookup fones

The internal DNS server was configured to provide the proper external IP address and port
information based on the type of service requested by the one-X Mobile Preferred clients.

The screen below shows the XMPP Service Location record. A DNS service (SRV) query for
XMPP returned iposerverxportal.sil. miami.avaya.com as the host offering the service on port
5222. This host is later associated with IP address “172.16.157.161”, the external Avaya SBCE
interface used for Remote Worker XMPP (one-X Portal) traffic. The Avaya SBCE relayed
XMPP traffic received on this interface to the Avaya one-X® Portal server via Relay Services
configured in Section 7.4.

3‘ DS _tcp 1 recordis)
E‘B SERVER1 Mame 7 | Tvpe | Data
EID Drward Lockup Zones _urnpp-client Service Location (SRY) [100][100][5222] iposerverxpartal . sil.miami. avaya.com
[TTEEd slomiami. avaya.com
: =0 iposerver
E _tep
u _kep
@k
D Reverse Lookup Zones
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The screen below shows the SIP with TCP Service Location record. A DNS SRV query for SIP
when using TCP returned iposerversip.sil. miami.avaya.com as the host offering the service on
port 5060. This host is later associated with IP address “172.16.157.160”, the external Avaya
SBCE interface used for Remote Worker SIP and media traffic.

F%' DkS _tep 1 record(s)
=-8 éRVERl Name 7 [ Tvpe | Data |
=1L Forward Lookup Zones _sip Service Location (SRY) [100][50][5060] iposerversip, sil.miami, avaya,com

| -l sil.miami,avaya.com |
=) D iposerver

E ko

_ts
I CI Reverse Lookup Zones

The Avaya one-X® Mobile Preferred for Android can be configured to use a secure connection
using TLS. The screen below shows the Service Location record for SIP with TLS. In this case a
DNS SRV query for SIP also returned iposerversip.sil.miami.avaya.com as the host offering the
service, but on port 5061.

,.3.. OkS _ts 1 record(s)
=8 ERVERI Namz 7 [ Tvpe | Data |
=L Forward Lookup Zanes _sip Service Location (SRY) [100][50][5061 ] iposetversip.sil, miami, avaya.com

I . ' slL.rlamnl, avaya, com I

= l_‘l iposerver

D Reverse Lookup Zones
@ Event Yiewer

The following screen shows the Host records, associating the hosts offering the telephony
(iposerversip) and one-X Portal (iposerverxportal) services in the sil.miami.avaya.com domain
to the respective external interfaces of the Avaya SBCE.

= DhS sil.miami, avaya.com 39 record(s)
B B SERVWER1 Marne  / | Tvpe | [rata
=L Forwsrd Lookup Zones {zame as parent Folder) Mame Jerver (N33 serverl,
L e .&rq::orzle‘:::fa ) | E (same as parent Folder) Mame Server (N3) serverl,sil.miami, avayva.com,
D tep {zame as parent Folder) Skart of Authority (S0A) [124], serverl., hostmaster,
@ e
[]--D Reverse Lookup Zones s
[]..@ Event Yiewer E aa-she Hosk (&) 192.168.10.42
] aa-shc-cdom Host (A) 192.168.10.41
g450main Host (4] 192,168,10.50
g450remote Huosk (&) 10,10.10.15
Diposerver
iposeryversip Huosk (&) 172.16.157.160
iposerverxportal Host (A) 172.16.157.161
=| me-aes Huosk (&) 10.5.5.18
2] me-cdom Hast (4] 10.5.5.11
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For a customer deployment, the one-X® Mobile Preferred clients may require to register to the
IP Office as remote workers on the public network, and additionally to register to the IP Office
locally on the private enterprise network. In this case Avaya recommends to use split DNS,
where different sets of DNS information are provided depending on the source address of the
DNS request. In the reference configuration, the remote workers resided solely in the untrusted
network and subsequently split DNS was not necessary.

9. Avaya Flare® Experience for Windows Configuration

The following screen illustrates the Flare® Experience for IP Office client configuration. The
Server address is the external IP address of the Avaya SBCE used for Remote Worker SIP and
media traffic. The Server port is 5061 and the Transport type is set to TLS. The Domain was
set to sil.miami.avaya.com, the domain configured in the IP Office LAN1 settings in Section
5.2.

A Avaya Flare Experience

Not logged in v

My Contacts v

¥ Settings

Server Server

Dialing Rules Server address 172.16.157.160

Enterprise Search
Contacis Server port 5061

Audio Transport type © TLS @ TCP

Video Port is optional. If not specified, the default will be used (TLS=5061,
Conference TCP=5060).

Aoout
Support
i Presence server address _

_AVAVA
1 VA
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10. Avaya one-X® Mobile Preferred Client Configuration

This section illustrates the administration settings on the Avaya one-X® Mobile Preferred for IP
Office clients used in the reference configuration.

10.1. Avaya one-X® Mobile Preferred for IPhone

The following screen shows the settings used on the one-X® Mobile Preferred for IP Office
clients, in the 10S version. Note that the Server 1D was set to the FQDN of the XMPP Domain
Name in the Avaya one-X® Portal server (Section 6.2). The VolP Mode was set to operate on
WiFi Only mode.

sscoo ATRT 5 9:35 AM

9:35 AM

eeeno ATET & 9:35 AM

VolP Mode

Cancel Settings Cancel Settings Done
UC Server Settings Publish Location
Never
Server ID iposerver.sil. miami.avaya.co Share Your Location
WiFi Only v
Username  SIP4002 Location Precision
Always

Password ®eee

Send Logs

System Messages

Application Configuration

olP Mode

Do Not Disturb

Dial Plan Configuration

Dial Plan

Call Monitoring

Active Call Monitoring m -\}

() oFF
Prevents your phones fram ringing
y —y - - ™
Publish Location Monitor Connection m
. P .
Share Your Location () OFF External Ringer =

Always alert calls through speaker “—

Click the Call Facility icon on the screen. Select VolP to be able to make and receive calls from
the client. At this point the phone sends a DNS SRV query for SIP to the DNS server, and once it
gets the proper response, it will send a SIP registration to the IP Office via the Avaya SBCE. The
green handset icon should pop up at the bottom of the screen.

escio ATAT = ATST =

Cancel

J voip

W Call me back on...

Mobile

Home

Work

Custom

! Available | Available

L]

Home

L
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10.2. Avaya one-X® Mobile Preferred for Android
The one-X® Mobile Preferred for IP Office Android version was similarly configured:

Server ID and user account

VolP operation mode

ar |D

— Never

Username Alw ays ® D volP
SIP4010 . — P Call me back on...
seao N LwiFiony ®

Wi-Fi Only With
Mobile Fallback

Cancel

Navigate to Settings > Advanced - Advanced VolP. Select Secure Connection to allow for
TLS communication to the Avaya SBCE.

Logging setungs

Logging Level
Select logging level
Log limit (MB)
Log File Size Limit
XMPP debugging
Extra XMPP debugging

File Transfer Options

Wi-Fi Only v

File transfer using WIFI anly

!

Pending file transfers

ng file

Voice Over IP

Advanced VolP
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11. System Verification

The following sections include steps that may be used to verify the functionality of the Remote
Worker configuration covered on the previous sections.

11.1. Avaya IP Office

The Avaya IP Office System Status and Monitor applications are useful tools used for the
verification and troubleshooting of the SIP connection of the Remote Workers to the IP Office.

11.1.1. System Status

The Avaya IP Office System Status application can be used to verify the successful registration
of the Remote Workers to the IP Office. Launch the application from Start - Programs - IP
Office > System Status on the PC where Avaya IP Office Manager was installed. Under
Control Unit IP Address select the IP address of the IP Office system under verification. Log in
using the appropriate credentials.

Online | offline

Logon

Control Unit IP Address: [RULERR -
Services Base TcP port

Local IP Address: [

@ Auto reconnect

Logon
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Select Extensions from the left pane. In the example, extensions 4002, 4006 and 4010 are
registered Remote Workers users. Note that the IP Address shown for these extensions, as seen
from the IP Office, is 10.5.5.153, which corresponds to the private interface of the Avaya SBCE
used for Remote Workers.

S Byaya TP Office System Status - Primary (10.5.5.90 - IP Office Linux PC 9.0.5.0 build 972 [r=e| =]

AVAyA IP Office System Status

Extension Summany
“ou can get mare information about an extension by dauble-clicking the Extension Mumber,

Active Calls
HE Resources

= icemail 4001 4001 Ext4001 192.165.10.1585 00-1E-4F-534-D6-12 9620 Mone
e 4002 4002 $1.51P4002 10.5.5.153 Avaya One i Mobile 1 None
. 4006 4008 %1.Flare SIP 4006 10,5,5,153 Avaya Flare 1] Mane
4010 4010 $1.5IP4010 10.5.5.155 Avaya One X Mobile a Mone

Crling

Additional status and call tracing information can be obtained by double-clicking the extension
number of a particular extension:

Extension Status

Extension Number: 4006 -
IP address: 10.5.5.153 I
Active Location: Mone
Telephone Type: Avaya Flare
User Agent: Avaya Flare Enginef1.1.0 (Avaya 1.1 13; Windows NT 5.1)
Layer 4 Protocol: TCR
Current User Extension Mumber: 4006
Current User Name: £1.Flare SIF 4006
Forwarding: Off
Twinning; Off
Do Mot Disturb: Off E
Message Waiting: Off
Mumber of New Messages: 0
Phone Manager Type: None
SIP Device Features: REFER,,UPDATE
License Reserved: MNa
Last Date and Time License Allocated:
Packet Loss Fraction: Connection Type: WCM
Jitter: Codec: G711 Mu
Round Trip Delay: Remote Media Address: 10.5.5.91 R
Call Ref Current State Time in State Calling Mumber or Called  Direction Other Party on Call
MNumber
(i) 11 Connected 00:00:33 4056 Outgeing Line: 1 H.323 10.5.5.91 Channel: 1 =
Trace Output:
14815 5:40:14 PM-330ms Line = 1, Channel = 1, Line Ref= 1048, 0.931 Message = Setup, Call Ref = 11, Direction = Frem Switch, Calling Party Number = 4008, Called Pa =
14815 5:40:14 PM-345ms Line = 1, Channel = 1, 1.931 Message = CallProceeding, Call Ref = 11, Direction = To Switch -
4 | 1 | I
[ Trace Clear ] [ Pause ] [ Ping ] [ Back ] Call Detzils [ Print... ] [ Save As... ]
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11.1.2. Monitor

The Avaya IP Office Monitor application can be used to monitor and troubleshoot signaling
messaging from the Remote Workers. Launch the application from Start - Programs - IP
Office > Monitor (not shown) on the PC where Avaya IP Office Manager was installed. Click
the Select Unit icon on the taskbar and Select the IP address of the IP Office system under

verification.

File Edit ‘iew Filkers Status Help

Iﬂ_ Avaya IP Office Sys™Monitor - [STOPPED]

=8| »[E|T| x[> F

< | e

*

Start/Stop
Trace

p 4

Trace Select
Qptions  Unit

Clicking the Trace Options icon on the taskbar and selecting the SIP tab allows the
modification of the threshold used for capturing events, types of packets to be captured, filters,
etc. Additionally, the color used to represent the packets in the trace can be customized by right

clicking on the type of packet and selecting to the desired color.

ATM | cCal | DTE | ECont | FrameRelsy | GOD | H323 | Intesface |
T | VPN | Wi | SCN ] Jade
ISDN ] Kq,vLan'uI Dil-ﬂl::lclry] Madia | PPP | R2 I Fh:lulinu] Servces Eyslem
Events
M Sip [Low = ™ STUN ™ SIP Dect
Packets
[~ SIP Reg/Dpt A= [~ SIP Misc R=
[~ SIP Reg/Dpt Tx [~ SIP Misc Tx
[# SIF Call Fx I~ Cm Motily By
¥ (SIP Call T ™ ConNotily T
¥ Sip Rx ™ hes IF Filter [man.nnn. frm re]
[+ Sip Tx [~ hes [
Default Al | Cloar Al | TabClearsd | Tabseta oK Cancel
Save File J Load File | Select Fia J
MAA,; Reviewed: Solution & Interoperability Test Lab Application Notes 46 of 51

SPOC 2/17/2015 ©2015 Avaya Inc. All Rights Reserved.

RemW_IPO9SBCEG3



11.2. Avaya Session Border Controller for Enterprise
There are several links and menus located on the taskbar at the top of the screen of the web
interface that can provide useful diagnostic or troubleshooting information.

Alarms: Provides information about the health of the SBC.

Settings Help Log Out

o[- =)

&) Certificate error

AVAYA

Alarms  Incidents  Status Logs Diagnostics  Users

2 Alarms - Windows Internet Explorer provided by Avaya IT
|2 https://192.168.1075/sbc/lst

Alarm Viewer

[ Devices VAR

EMS
V] D Details

State Time Device

lrEu SETE No alarms found for this device

| Clear Selected || Clear Al |

Incidents : Provides detailed reports of anomalies, errors, policies violations, etc.

Alarms  Incidents  Status Logs Diagnostics  Users Settings Help Log Out
@ Incident Viewer - Windows Internet Explorer provided by Avaya IT EI@
|2 hitps//192268.00.75 5k c st @ Certificate error |

- - ~
Incident Viewer AVAYA
Device Category [All ~| [ Clear Filters | Refresh || Generate Report ‘

Displaying results 1 to 15 out of 2002.
Type D Date Time Category Device Cause
Message Dropped 710935586649043 12115 312PM  Policy Micro_SBCE  Method Prohibited Cut-of-Dialog
Routing Failure 710935515199320 121115  310PM  Policy Micro SBCE  Target is neither a server nor a subscriber, Sending 403 Forbidden
Message Dropped 710935436653471 1721115 307 PM  Policy Micro_SBCE  Method Prohibited Out-of-Dialog
47 of 51
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Under Status - User Registrations, a list of users registered via the Avaya SBCE and their
current status is shown:

B=~ O

Settings Log Qut

Alarms  Incidents  Status Logs Diagnostics  Users

Help
SIP Statistics
Session BEEEEEtroller for Enterprise AVAYA
Server Status
=)

€ Certificate error |

AVAYA

{22 User Registrations - Avaya Session Border Controller for Enterprise - Windows Internet Explorer provided by Avaya IT

@ https://192.168.10.75/sbc/list

User Registrations

Displaying entries 1to 2 0f 2

SIP Instance SBC Device SM Address Registration Siate Last Reported Time
[Contains VH | [Cantains VH | [Contains || | [Cantains VH ‘ [Contains ][ ‘ [Contains VH ‘ ‘ Filter |
4006@sil miami avaya com D0ffaf3d12ff Micro_SBCE 105 5.90 (PRIMARY) REGISTERED 01/21/2015 15:25:17 EST Details
4010@sil miami avaya com Micro_SBCE 10.5.5.90 (PRIMARY) REGISTERED 01/21/2015 14:25:24 EST Details

Additional information can be obtained clicking the Details link for a particular user:

View Registration Information ; 4010 sil.miami.avaya.com

User Information
AOR 401 0@sil.miami.avaya.com
SIF Instance
Controller Mode Mo
User Agent Avaya One X Mobile Android Generic 1.9.0.9989 motarola XT1028
Firmware Awaya

Servers

IP

Micro_SECE  oneXMobile 0 82 iom E,E-Rﬁﬁfgﬂ 5060 TCP 10.0.0.6 17246157150 TLS REGISTERED 11212015
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Additionally, the Avaya SBCE contains an internal packet capture tool that allows the capture of
packets on any of its interfaces, saving them as pcap files. Navigate to Device Specific Settings
- Troubleshooting - Trace. Select the Packet Capture tab, set the desired configuration for
the trace and click Start Capture.

Session Border Controller for Enterprise AVAYA
» TLS Management 2l Trace: Micro_SBCE
4 Device Specific Settings
MNetwork
Management Call Trace | | Packet Capture | [ Captures
Wedia Interface Micro_SBCE Packet Capture Configuration
Signaling Interface Bielios feady
End Paint Flows Interface Any ¥
Session Flows
Local Address = -
> DMZ Services IP[:Par] Al :
TURN/STUN Service Remote Address lw—
SHMP " "Fort, IF, IF:Fort
Svyslog Management Protacol Al =
Advanced Options Maximum Mumber of Packets to Capture 1noog
< Troubleshaoating
Capture Fil
Debugging Us?r?g &I’:’S r\alrr?ang'n;E exicting capture will ovennite it ItESt poap
Trace =
D05 ;I Start Capture | Clear | -

Once the capture is stopped, click the Captures tab and select the proper pcap file. Note that the
date and time is appended to the filename specified previously. The file can now be saved to the
local PC, where it can be opened with an application such as Wireshark.

Call Trace || Packet Capture | Captures

Refresh |

File Mame File Size (bytes) Last Modified
test_20141201103347 peap 118 784 December 1, 2MADIALOTAM  polers
MAA,; Reviewed: Solution & Interoperability Test Lab Application Notes 49 of 51

SPOC 2/17/2015 ©2015 Avaya Inc. All Rights Reserved. RemW_IPO9SBCE6G3



12. Conclusion

These Application Notes describe the procedures necessary to configure Avaya IP Office 9.0 and
Avaya Session Border Controller for Enterprise 6.3 to support Remote Workers, in the reference
configuration shown in Figure 1.

Interoperability testing of the sample configuration was completed with successful results for all
test cases with the exception of the observations/limitations described in Section 2.2.
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